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Device List

A DIGIFORCE 9310 device is identified as either a device or station.
The device list is only available after a Device Search has been carried out and DIGIFORCE 9310
have been found.
If you have connected several devices to your PC via a RS 485 converter, several stations will be
listed in the device list following a device search.
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You need to select the station with which you would like to work before executing any type of action.
The corresponding station name or serial number will appear in the title bar of most dialog windows.
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File Checksum (Digital Signature)
A File Checksum (Digital Signature) is a checksum of all parameters and data of the related file.
This Digital Signature will be integrated in the created Backup-, Protocol or Statistic file and it gives
information about a possible manipulation of the file after creation.
A file classified as manipulated if the parameter in the file were changed from hand and then saved.
Please note that a Digital Signature is present from the DigiControl version 2003.1.0.

Help version
This Windows online help documentation refers to the DigiControl 9310 Version V2004.5.0.
2002-2004 © burster präzisionsmeßtechnik gmbh & co kg
Creator: Thomas Meder / 03.12.2004

Contact manufacturer
If you have any questions regarding the DigiControl 9310 or DIGIFORCE 9310, you can contact the
manufacturer at the following address:
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Known Problems
Formatting / Calculating Error
In some operating systems the comma isn't supported by DigiControl 9310 as a Decimal Symbol.
In these cases you get a message from DigiControl 9310 and you must change the Decimal Symbol
from comma into point. Otherwise DigiControl 9310 does not work error free!

Graphic Representation Problem
The Font Size settings of the operating system must be adjustet to 'Small Fonts' or 'Large Fonts'.
Please do not adjust a 'user-defined' or 'Other' Font Size otherwise some representation problems could
appear.
In these cases you get a message from DigiControl 9310.

Problems with print-out of reports or protocols
For the print-out of all protocols and reports you need read/write access inside of the DigiControl 9310
installation directory. Please contact your system administrator if necessary.

Communication with DIGIFORCE 9310
There are two possiblilities to communicate with the serial interface: RS 232 (connector at the front
side of DIGIFORCE 9310) and RS 485 Full Duplex (rear side of DIGIFORCE 9310).
If you have some problems with the communication please read the FAQ.
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Frequently Asked Questions (FAQ)
•

How can I copy measurement programs?
Refer to the instructions on program copying.

•

Can I install and start multiple instances of the DigiControl 9310 on the same computer?
The DigiControl 9310 can only be installed and run once on any computer.

•

Is the DigiControl 9310 compatible with older and newer DIGIFORCE 9310 devices /
versions?
DigiControl 9310 should be compatible to all device versions of DIGIFORCE 9310.
But if the DIGIFORCE 9310 software is newer than the DigiControl 9310 software and some new
features were unknown, you must perform a DigiControl 9310 software update.
If you have some other problems please refer to our software support: Software@burster.de.

•

Why does DigiControl found no devices with the device search?
• Check if the interface cable is OK.
• The stereo jack for the RS 232 connector at the front side is not a usually 3,5 mm stereo audio
jack but it is a special. Therefore you should use the original burster interface cable set!
•
Eventually test all used wires of the interface cable.
•
Check if the interface settings of DigiControl and DIGIFORCE are identical.
• Please make sure that you left the menu “RS232 + RS485” in the DIGIFORCE 9310 if you
start to communicate with the device because a change of the interface settings is not active.
• Is the selected Interface port (COM) installed and configurated in the System Control of the
PC?
• Is the selected Interface port (COM) already used by an other driver or device?
In much cases synchronisation manager of PDA’s or organizers are installed and active in
the background!
• Notes for the use of the RS 485 interface you can find here.

•

DigiControl 9310 should be compatible to all device versions of DIGIFORCE 9310.
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Find Devices
In order to use DigiControl 9310 online to work with DIGIFORCE 9310 devices, you first need to find
and specify the devices. The interface (COM1 to COM4) that you have set up will be searched for the
devices.
For this reason it is essential to pay attention to the interface default settings!
Please note that the existing device list is deleted during each device search. As a result, the new
settings can only be adopted after the program has been exited!
In addition, please be sure that you have not activated the menu ”RS232 + RS485”on the
DIGIFORCE 9310 before starting the device search. Otherwise, the device settings will not yet be
activated.

There are various options for searching the interface for devices:

Simple Device Search
In order to search for devices on the basis of interface parameters in DigiControl, simply click on the
Search Devices button
.
The progress bar indicates the status of your search.
If all existing devices appear in the list, you can Cancel the search before it is completed – the devices
listed are not affected.
You will be informed of the number of devices found when the search is completed.

Extended Device Search
To start the extended device search, press the [ALT] button while clicking on the Search Devices
button
. A selection dialog window appears in which you can define the
extended device search before starting it:
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It is possible to include the parameters Baud rate settings, Blockcheck On or Off and all Data formats
to automatically search for the DIGIFORCE 9310.
If a device is located, you have the option of searching for additional devices in this interface setting.
To do this, confirm the following dialog window with Yes or click on No to select this as the only
existing device:

Important note: Please note that there are up to 27,500 possibilities for the device search depending on
the definition. As a result, the extended device search could take up to several days! Please limit the
extended device search options as narrowly as possible.
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Station Properties
[Double click a Station in the device list]

The station name, DIGIFORCE device serial number and DIGIFORCE 9310 software version (in
parentheses) are displayed in the title bar of this dialog window.

General
Device-specific characteristics, such as the Calibration Date, Software Version and Serial Number of
the DIGIFORCE 9310 are displayed in this dialog window.
In addition, you can change or adapt the name in the Station Name field to the format used for the
DigiControl 9310. This Station Name is also copied in the DIGIFORCE 9310 device as the Station
Name. The maximum length for the Station Name is 10 characters.
The Address cannot be changed. This is assigned individually in the device search.
Any changes to the Station Name will only be adopted if you click on the OK button – the Cancel
button rejects any changes made in this dialog window!
Note: If the plant calibration is not to be used in the DIGIFORCE 9310, the date in the Calibration
Date field is highlighted in red and an additional note is displayed –DIGIFORCE 9310 should not
be used in this condition!
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Command Interpreter
[Mark a Station in the device list -> Edit -> Command Interpreter]

This command interpreter makes it possible to send interface commands to the device as described in
the DIGIFORCE 9310 manual.
This is practical if you create your own PC program and would like to test specific interface
commands for functionality, for example.
In order to call up this dialog window, select a station from the device list. Now, follow the menu path:
‘Edit’ ->‘Command Interpreter’.
The station name and DIGIFORCE 9310 device serial number are displayed in the title bar of this
dialog window.
With the option Only accepted commands you activate the DigiControl internal history table of all
parameter commands to check the current command if it is valid.
Now, for example, you can enter the command INFO? in the Command Send String field and click
on the Send button. The device returns the current device information to the Command Receive String
field.
Exit the dialog window by clicking on the Quit button.
Note: If the command string entered is invalid, contains invalid parameters or another error occurs,
a message to this effect is displayed when you send the command string.
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Device Selection

If device parameter processing was started offline from a backup parameter file or completely new and
DIGIFORCE 9310 devices have already been entered as stations in the device list, you can select a
station to transmit the parameters.
Please note that only the program or parameter currently processed is transmitted to the device.
Existing device settings are erased in the process!
Select a device (if several devices are included in the list) and confirm your selection by clicking on
the Continue button.
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Measurement Mode
[Double click a Station in the device list -> Measurement Mode]

Configure the properties for the measurmement mode in this rubric.

Data Collection
Select what kind of data you really want to collect and transmit from DIGIFORCE – separately for
evaluation result OK and NOK.
1) Only general results
With this settings only the general curve data and the common result will be transmitted.
2) General result and measurmement curve
Transmission like 1], additional the measuremement curve.
3) General, Window and Envelope results
Transmission like 1], however the settings and results of all active evaluation windows and the result
of an active envelope (without envelope curve) will be transmitted.

Operation Manuel

PC-Software DigiControl 9310

Page 18 to 128

4) General, Window and Envelope results; Measurement, Envelope and Trend curve
In this position additional to point 3) the measurment, an active envelope and trend curve will be
transmitted. Certainly this uses the longest time for the data transmission.
Important Note: Only transmitted measurement data can be processed at any time.
You should know this if you want analyse measurement data.

Remark
Edit some Remark (max. 64 characters) which will be saved in each measurement protocol. This
remark is visible at a Protocol printout.

Charge
You can select between a manual definition and an automatic, time based Charge identification.

Part-No.
The Part-No. exists of a counter id which is the DIGIFORCE counter or an other current counter.
Optional an aphanumerical character block can be set to the fields %1 or %2 with a length of
maximum 32 characters.
Last Part-No.
In this field you can see the last (spent) value of the part-No. which was used for the creation of a
measurmement protocol. You can edit this value by hand.
Next Counter No.
In this field the next value of the Part-No. which was used for the creation of the next measuremement
protocol will be showed. This value must be greather or equal than 0 and will be set to 1 if it is
greather than 2147483647.

Component
You can select between program name of the current DIGIFORCE programm or a manual definition.
However it is meaningfull to use an articulate component name to find and assign this component
later.
The maximum length of the manual component name is 32 characters.

Note: Active Device Group
If a device group is activated the properties Charge, Part-No. and Component Name refers from the
device group for all devices.
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Statistic
[Double click a Station in the device list -> Statistic]

The OK / NOK Statistic for a complete day (24 hours) of the current selected device will be showed in
the graphic.
At every new day the statistic begins from new if the measurement mode is active.
The presentation is optionally Parallel or Among each other.
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Parameterize
[Parameterize (New, from File, online)]

You can create new parameterization files (File -> New), open them from a parameter file (backup) or
read the parameters directly from the selected device online.
If you call up the Parameterize Dialog online the program names will be displayed at the program
buttons with DIGIFORCE 9310 software version V200303 and higher.
You can switch between the following tab pages after calling up the Parameterize dialog window:

General Settings
The basic settings for the following parameters in DIGIFORCE 9310:
•
User language
•
OK/NOK display
•
Display (LCD contrast)
•
Current display mode
•
Profibus settings (optional)
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Access Permission
•
•
•

Assignment of master and user passwords
Protection activation
Access levels for users

Programs
•
•
•

Active program specification (0 –7)
Selection of program to be processed (0 – 7)
Copying of programs

Save Device Parameter
The data from all Parameterize dialog windows can be saved in a backup file. If the file already exists,
you can add the parameters to the file ‘Supplement’ or ‘Replace’ the file completely (the file is deleted
and a new one is created with these parameters):

Transmit
The data in all Parameterize dialog windows is transmitted to the device following a confirmation
prompt and the dialog window is closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to first save the data, click on the Save Device Parameter or Transmit fields.

Note: As soon as you have changed at least one parameter in the Parameterize dialog the state was
set to not saved/transmitted. .You discard the changes if you cancel the Parameterize dialog (with
accepting the security message which you can deactivate and if necessary activate in the General
Settings – Presentation. The Parameterize dialog window contains the following tab pages: Basic
Settings, Access Permission and Programs.
The changes that you have made only become effective in the device if you click on the Transmit
button in the Parameterize dialog or save the changes by clicking on the Save Device Parameter
button.
Please note that the data of the Parameterize dialog (and not the program parameter of program 0 –
7!) is only saved or transmitted when these corresponding procedures are executed.
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Basic Settings
[Parameterize (New, from File, online) -> Basic Settings]

Operation Language
Setting of the operation language used in the DIGIFORCE 9310.

OK/NOK Display
NOK Part:
Display:

The NOK measurements can be displayed as a percentage value or absolute number of
NOKs with respect to the overall measurements in the Total Result display mode.
You can choose either a text (Text OK or NOK is displayed) or a ”smiley face” for the
Total Result evaluation display.

Display
LCD Contrast: Set the device display contrast using the variable bar. The input limits
are between 0 (bright) and 9 (dark).

Current Display Mode
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Specify which display mode is to be displayed when transmitting the settings. The requirement here is
that the corresponding Display Mode is released (Programs – tab Presentation) in the Active Program
(Parameterize Programs)

Profibus (optional)
Address:
interface.
Digital Inputs:
Monitoring:

Adjust the profibus address (0-127) for the communication by profibus
Definition of the Digital Inputs. Choice between SPS or Profibus.
Monitoring On or Off.

Save Device Parameter
The data from all Parameterize dialog windows can be saved in a backup file. If the file already exists,
you can add the parameters to the file ‘Supplement’ or ‘Replace’ the file completely (the file is deleted
and a new one is created with these parameters):

Transmit
The data in all Parameterize dialog windows is transmitted to the device following a confirmation
prompt and the dialog window is closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to first save the data, click on the Save Device Parameter or Transmit fields.

Note: As soon as you have changed at least one parameter in the Parameterize dialog the state was
set to not saved/transmitted. .You discard the changes if you cancel the Parameterize dialog (with
accepting the security message which you can deactivate and if necessary activate in the General
Settings – Presentation. The Parameterize dialog window contains the following tab pages: Basic
Settings, Access Permission and Programs.
The changes that you have made only become effective in the device if you click on the Transmit
button in the Parameterize dialog or save the changes by clicking on the Save Device Parameter
button.
Please note that the data of the Parameterize dialog (and not the program parameter of program 0 –
7!) is only saved or transmitted when these corresponding procedures are executed.
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Access Permission
[Parameterize (New, from File, online) – Access Permission]

Password Assignment
You can assign the master and user passwords here. Only numeric values may be used when entering
the password and the length is limited to 4 digits.
After you have entered a new password, confirm this by entering it again for security reasons.

The entered passwords are displayed with asterisks for security reasons. Please note that these are
passwords for DIGIFORCE 9310 and are not the passwords for theDigiControl 9310 PC Software!
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Protection
In order to activate the password protection in DIGIFORCE 9310, a checkmark must be placed in the
option field Activated.
If you do not wish to have password, remove the checkmark from the Activated option field.

Access Level for ‘User‘
Use the option fields to specify the levels at which access Protection should be provided.
Please consult the DIGIFORCE 9310 for additional details regarding the individual access levels.
Please note that at least one access level needs to be activated!

Save Device Parameter
The data from all Parameterize dialog windows can be saved in a backup file. If the file already exists,
you can add the parameters to the file ‘Supplement’ or ‘Replace’ the file completely (the file is deleted
and a new one is created with these parameters):

Transmit
The data in all Parameterize dialog windows is transmitted to the device following a confirmation
prompt and the dialog window is closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to first save the data, click on the Save Device Parameter or Transmit fields.

Note: As soon as you have changed at least one parameter in the Parameterize dialog the state was
set to not saved/transmitted. .You discard the changes if you cancel the Parameterize dialog (with
accepting the security message which you can deactivate and if necessary activate in the General
Settings – Presentation. The Parameterize dialog window contains the following tab pages: Basic
Settings, Access Permission and Programs.
The changes that you have made only become effective in the device if you click on the Transmit
button in the Parameterize dialog or save the changes by clicking on the Save Device Parameter
button.
Please note that the data of the Parameterize dialog (and not the program parameter of program 0 –
7!) is only saved or transmitted when these corresponding procedures are executed.

Operation Manuel

PC-Software DigiControl 9310

Page 26 to 128

Programs
[Parameterize (New, from File, online) -> Programs]

Active Program
The displayed value corresponds to the measurement program active in DIGIFORCE 9310 when the
dialog window is called up. If you would like to activate a different measurement program, enter the
desired measurement program number (0 - 7) in this field.

Programs
In order to process a measurement program, select the corresponding program number button.
If a DIGIFORCE 9310 is connected and you are working online with the device, the current program
data for the selected program number are imported into the DigiControl 9310 and are displayed in the
Program dialog window.

Copying programs
If you would like to copy measurement programs, click on the program button to be copied. Keep the
mouse button pressed while you move the mouse cursor (Copy object) to the program button in which
the program is to be copied.
This function is only available for online parameterization with a device.
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Save Device Parameter
The data from all Parameterize dialog windows can be saved in a backup file. If the file already exists,
you can add the parameters to the file ‘Supplement’ or ‘Replace’ the file completely (the file is deleted
and a new one is created with these parameters):

Transmit
The data in all Parameterize dialog windows is transmitted to the device following a confirmation
prompt and the dialog window is closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to first save the data, click on the Save Device Parameter or Transmit fields.

Note: As soon as you have changed at least one parameter in the Parameterize dialog the state was
set to not saved/transmitted. .You discard the changes if you cancel the Parameterize dialog (with
accepting the security message which you can deactivate and if necessary activate in the General
Settings – Presentation. The Parameterize dialog window contains the following tab pages: Basic
Settings, Access Permission and Programs.
The changes that you have made only become effective in the device if you click on the Transmit
button in the Parameterize dialog or save the changes by clicking on the Save Device Parameter
button.
Please note that the data of the Parameterize dialog (and not the program parameter of program 0 –
7!) is only saved or transmitted when these corresponding procedures are executed
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Save Device Parameters
In order to save the changed parameters of a DIGIFORCE devices to a file, enter a unique name for
the file in the File name field. The files are saved in text format and can therefore be viewed using a
text editor.
The device parameters are always stored in the subdirectory (from DigiControl) Param. You can also
select a different path to save the file by selecting Change in the same dialog and choosing the desired
directory.
The file is stored in the selected directory when you click on the {Button Save.bmp} button.
Important notes: If you change device parameter from a Backup-File or save some device parameter
into a Backup File, the Digital Signature of the Backup File possibly will be invalid!
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Device Parameters
Basic Settings – Measurement Programs
Device parameters refer to the DIGIFORCE 9310 device settings.
These can be separated into the general settings, which are displayed in the Parameterize program
dialog window, and the measurement programs (Program dialog window programs 0-7).
Both types of device parameters are created and processed separately. The programs are configured
independently of each other (programs 0-7).

Download - Upload
All DIGIFORCE 9310 settings are saved to a backup file when downloading (DIGIFORCE 9310 ->
Backup File).
When uploading, all settings are loaded from the backup file to the DIGIFORCE 9310.

Create New Device Parameters
You can create new device parameters offline by clicking on the
in the main dialog window or
by following the menu path: File –> New….
When new device parameters are created, the general settings (which correspond to the settings for a
new device) are loaded into each dialog window and are displayed.
You can Change and Save these parameters or Transmit them to the device.

Open Saved Device Parameters
You can load and process saved device parameters offline by clicking on the
in the main dialog
window or by following the menu path: File -> Open….
When the file is opened, the parameters are loaded into the dialog windows and are displayed as they
are saved in the file.
You can Change and Save these parameters or Transmit them to the device.

Parameterize
In order to process device parameters online, select the device in the device list and click on the
Parameterize button. The basic parameters are then loaded.
You can access the parameters for the individual measurement programs in the Programs tab page.
You can Change and Save these parameters or Transmit them to the device.
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Programs
[Parameterize Program (New, from File, online)]

You have the option of defining a maximum of 8 measurement programs (0-7) in DIGIFORCE 9310.
Enter a name for the current measurement program in the Program Name field. You can only load,
edit, save or transmit one measurement program at a time.
The following tab pages are displayed in the Program dialog window:

Channel Settings
Setting and calibration of both measurement channels X and Y for the DIGIFORCE 9310.

Measuring Mode
Definition of measurement mode and accompanying parameters.

Sensor Test
Manual entry or teach-in of reference point and specification of tolerance values for both channels X
and Y respectively.
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Evaluation
Assignment of maximum 3 evaluation windows with their rating criteria and an envelope with Trend
tracking curve.
Online measuring of current measurement curve with DIGIFORCE 9310 and optimisation of the
evaluation window via graphic presentation.
In addition, you can save the measurement curve graphics, load them again offline without
DIGIFORCE 9310 and change the evaluation window settings.

Switch Points
Setting of both switch points S1 and S2 as well as the accompanying parameters (channel, reference).

Presentation
Release of 5 program-specific measurement menus and Reduction of the Curve Values for the
Production Measurement Mode (optional DigiControl 9310 version).

Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):

Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.
Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Channel Settings X/Y
[Parameterize Program (New, from File, online) -> Channel Settings]

Sensor Type Channel X
Select the sensor type (Standard Signal or Poti) used for channel X.

Input Range Channel X
If Standard Signal was selected, you need to select the Input Range (5V or 10V) for channel X.

Sensor Type Channel Y
Select the sensor type (Standard Signal 5V or Strain Gage) used for channel Y.

Excitation Channel Y
If Strain Gage was selected, you need to set the sensor excitation for channel Y (2.5V or 5V).

Input Range Channel Y
For Piezo devices you can select a Input Range value (1 nC – 400 nC) for the Y channel.

El. Level
This Piezo device parameter is a combination of the Upper Calibration Value and the Input Range.
This value is only a “pocket-calculator” function and on account of rounding differences it is possible
that the value insignificant differ from the device value.
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Selected Unit X/Y
You have the option of choosing between the specified units and the user-defined unit for each
respective channel.
Enter the user-defined unit in the User def. Unit X/Y field. However, this entry is activated or selected
in the Selected Unit field! This corresponds to the first entry in the list.

User def. Unit X/Y
Separate entry of an user-defined unit for each channel, which is then selected via the Selected Unit
X/Y field.

Nominal Range Channel Y
If Strain Gage is entered, you can enter the Nominal Range of the sensor here. You can find this in the
sensor data sheet. Please note that the Nominal Range must be greater than or equal to the Used
Range!

Used Range Channel Y
If Strain Gage is entered, the used range of the sensor can be entered here. This is the sensor range that
you actually use. Please note that the End Value must be greater than or equal to the Used Range!

Invert Channel X/Y
DIGIFORCE 9310 can only evaluate positive X and Y values. It may be the case that either the Y or Y
channel run in a negative direction for certain applications. The activation of the Invert function is
only intended for such cases. This must be used with caution!
When the Invert function is activated, the measurement values of the respective channel are inverted.

Filter Channel X/Y
Definition of the device-internal software Filter in the DIGIFORCE 9310. Separate selection or
deactivation of values listed between 5Hz and 400 Hz for each channel.

Lower/Upper Scale Value X/Y
Specification of the lower and upper Scale Values for the X and Y channels based on the sensor used.
Please note that the Lower Scale Value must always be less than the Upper Scale Value!
Note: The Lower Calibration value is the sensor initial value at the Lower Scale Value – the Upper
Calibration Value corresponds to the sensor initial value at the Upper Scale Value.

Lower / Upper Calibration Value X/Y
Entry of Calibration Values directly in the number fields if known. If you would like to carry out a
teach-in directly online for the device, use the teach-in buttons displayed below the number fields.
Please note that the Lower Calibration Value must always be less than the Upper Calibration Value!
Note: The Lower Calibration value is the sensor initial value at the Lower Scale Value – the Upper
Calibration Value corresponds to the sensor initial value at the Upper Scale Value.

Teach-In X/Y
If you set parameters for a DIGIFORCE 9310 online, you can use a teach-in for the Lower X, Upper
X, Lower Y and Upper Y channels respectively.
The new teach-in values are displayed in the number fields after the teach-in has been carried out.
These values are first sent to the device after clicking on the Transmit button or are saved to a backup
file after the Save Device Parameter button has been used.
Only Piezo version DIGIFORCE 9310: If you want to perform a Y-Channel Teach-In with a Piezo
DIGIFORCE 9310 you must first teach the lower calibration value. By this step the charging amplifier
of the DIGIFORCE 9310 will be discharged for a short time.
Only after the Teach-In of the lower calibration value the upper calibration value is possible to be
teached.
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Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):

Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.

Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Presentation
[Parameterize Program (New, from File, online) -> Presentation]

Release Display Modes
You can grant a release of Display Modes for specific menus to allow only a limit number of Display
Modes to be selected from on the DIGIFORCE 9310. You can effect this release using the
corresponding option fields. If a checkmark is displayed, the corresponding mode is activated and can
be displayed.
Note: Please note that at least one Display Mode must be activated. Otherwise Menu 4 (Total Result)
was released!

Reduction of the Curve Values
With help of this controller you can enforce a reduction of the curve values in the measurement
production mode (as DigiControl 9310-P100). If this function is active only every X-th value pair of
the measurement curve was transmitted from the device to DigiControl. Thus the transmission time of
the measurement could be optimized for a faster production cycle.
But please note that it is not possible may be to show significant parts of the curve (like runaways or
peaks)!
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Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):

Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.

Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Sensor Test
[Parameterize Program (New, from File, online) -> Sensortest]
This function is available in DIGICONTROL 9310 firmware versions 200208 and higher!

You have the option of entering the Reference Point as well as the Tolerance Point values for
channels X and Y respectively.
You can also set the Reference Point in the device using the teach-in function online.

Reference Point Value
Enter value in the number field.

Teach-In
Teach-In of the Reference Point Value online with the DIGIFORCE 9310 device for channels X and
Y respectively.
Note: The value is determined directly in DIGIFORCE 9310. The previous value remains in
DIGIFORCE 9310. The new Teach-In value will take effect in the device only after the Transmit
button has been activated.

Tolerance Point Value
You can enter the tolerance (+ / -) for the Reference Point for channels X and Y respectively.
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Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):

Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.

Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Measuring Mode
[Parameterize Program (New, from File, online) -> Measuring Mode]

Function
Select from the Functions listed here. Please note that it may not be possible to set certain parameters
depending on the Function. For this reason, it may have to be deactivated or reset.

Sample Rate
The Sample Rate can be assigned a value between 0.000 and 1000.0 for every Function y=f(x).
If y=f(t) or y=f(x,t) is selected instead, a value between 0.2 and 500.0 must be assigned. An assigned
value that does not fall within this range will be reset when the Function is switched!

Reference
You have the choice between Absolute, Trigger, Final Force and Block Window.
Absolute refers to recording using the unchanged device measurement values.
Trigger (Y-Trigger) means that the X value is set to ”0” when a pre-defined Y value has been reached.
Final Force means that the X value is set to ”0” at the position of the last measurement point
displayed.
Block Window means that the X value is set to ”0” at the position at which the Y-min extends beyond
the block window (even outside of the block window area).
The Reference selection also has an impact on the other program parameters. For example, the
Trigger value can only be set if Trigger is also set as a reference.
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Trigger
The Trigger value can only be set if the Reference is set to Trigger. Otherwise, this setting has no
effect.

Show Until
Display until X-Max displays the maximum X with a maximum Y at the same time, if X is constant in
this area.
The same applies to Y-Max: The maximum Y is displayed with the maximum X at the same time if Y
is constant in this area.

PLC Tare
Specification of rate PLC interface tare function. You can select this from the list of options.

Start Mode
You can choose between external and internal here. The Start and Stop values must be defined for an
internal start.

Start
Enter a numeric value at which the measurement should begin. This is only possible for an internal
start!

Stop
Enter a numeric value at which the measurement should be stopped. This is only possible for an
internal start!
If this value is not reached, the measurement is stopped when the value falls below the start value.

Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):

Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.
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Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.

Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Switch Points
[Parameterize Program (New, from File, online) -> Switch Points]

Switch Points S1 and S2
You have the option of defining switch points, which set the corresponding PLC output signals.

Value
Enter the numeric values which need to be exceeded by the X or Y Channel measurement values in
order to switch the logical signals. The switched signal remains activated until the switch point value
is reached again.

Channel
Select the desired measurement Channel (X or Y) that is to be assigned to the corresponding switch
output.

Reference
If the switch signal is assigned to channel X, the reference (zero) point needs to be selected for this
switch signal. This is related to the absolute (calibrated) zero point or the trigger zero point.
If Reference Trigger is activated, the Switch Points only react after the start mode and trigger have
been reached!
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Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):

Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.

Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Evaluation
[Parameterize Program (New, from File, online) -> Evaluation]

Measurement Curves
Measure
If you press the button Measure the dialog Measure (Teach-in Array of Curves) appears. There you
can perform measurements with the device and the measurement curves were displayed in the graphic
and listed in the measurement list.
The measurement curves are separatly selectable and the selected curve was highlighted with the
evaluation color. If some curves should not be displayed they could be deactivated.
In the Measure mode you can see the number of measurement values of the curves.
You can edit the number of displayed measurement curves in the General Settings – Presentation.
Note: Evaluation windows and envelope settings are parts of a measurement program.
An array of curves is helpful for positioning evaluation windows and creating an envelope.
Curve array files and measurement programs were saved separately but in most cases a curve array
is only in cooperation with the associated measurement program meaningful.
Changes of the evaluation windows or the envelope are principle effective to the evaluation result if
they are transmitted to the device.
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Load / Save
It is possible to save an array of curves if they were Teached-in during Measuring.
You can load this curve array file at any time.
Please note that the size of the file increases if you record several curves!
Because of system requirements the loading and saving of curve arrays takes under Windows
95/98/Me/NT4.0 longer as under Windows 2000/XP.
Delete
Press the button Delete to delete all measurement curves in the list.
Curve Array Print-out
If you want to print-out a displayed curve array press the button Curve Array Print-out. The
common printer dialogs appear.
Active

In the measurement list you can find the column Active. Only these measurements which are
checked in column Active were actually used by following functions:
- Save
- Curve Array Pint-out...
- Envelope New...

Window
Before assigning the Type, decide which number should be assigned to the corresponding window. To
do this, click on a(n) (available) tab page (Window 1 – Window 3).
If this window has already been defined, all corresponding data is displayed and the window in the
graph is illustrated in blue.
The following settings always affect the window number corresponding to the activated tab page.

Type
You can select from the following window types:
•
Pass
(P)
•
Online
(O)
•
Block
(B)
When the window type is activated, a start value is initiated in the lower part of the graph.
In order to deactivate a window, ”Off” needs to be displayed for the Type. Otherwise, a Type was
defined for this Window.
It is possible to specify criteria for each evaluation window (window coordinates, entry, exit. The
evaluation is only considered OK if all defined criteria are met in the measurement. If one of the
evaluations doesn’t work, the window is evaluated at NOK.

Entry
Specify which side of the current evaluation window is to be the entry side.
If the actual entry side of the measurement curve does not correspond to that set in the Entry field, the
evaluation for this window and the overall measurement is NOK.
The entry side can only be defined for the pass and block windows. The online window has a fixed
definition.
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Exit
Specify which side of the current evaluation window is to be the exit side.
If the actual exit side of a measurement curve does not correspond to that set in the Exit field, the
evaluation for this window and the overall measurement is NOK.
The exit side can only be defined for a pass window. This is always right for the online window and
there is no Exit for block windows.

Coordinates
To enter the exact window coordinates, simply enter the corresponding values in the number fields
Xmin, Xmax, Ymin and Ymax. The window is initialised with a new value and is placed at the
corresponding position in the graph after you press Enter or click on another data field.
Notes:
- If a max value is less than a min value, for example, the values are automatically switched upon
confirmation (pressing the Enter button or entering another value field)!
- If the window values fall outside of the graph scale values, it may not be possible to see the window
completely or at all. In this case, you can display the entire graph again by clicking on the Auto button.

Draw, move Windows…
You can draw evaluation windows within the coordinate field (graph), display the measurement curve
while measuring and zoom.
You can execute the following functions directly using the mouse:
Shift evaluation window:
Click on the active window (blue) (only if tab Window is selected) with the mouse pointer and move it
to a new position.
Change size of evaluation window:
Click on the active window (blue) (only if tab Window is selected) with the mouse pointer and on then
on the little arrows to change the size.
Draw evaluation window:
Drawing with the right mouse button (only if tab Window is selected).
Capture zoom area:
Draw using left mouse button while keeping the [STRG] button pressed.

Envelope
If a measurement program with envelope settings were loaded or transmitted from DIGIFORCE you
can see the envelope settings. To change this settings please press the button Change. Then the dialog
Edit Envelpe appears.
To create a New envelope you need an Array of Curves which is possible to Teach-in (Measure) or
load from Curve Array File.
With the options Show Envelope Curves and Show Trend Curves you can display existend curves in
the graphic.
But the real state of the envelope (On/Off) is independent from this options!
To change the display settings of the envelope please open the General Settings - Presentation or
General Settings - Colors.
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Zoom
The scaling of the measurement curves’ graphic is meant by Zoom. You have the choice of Manual
and Auto.

Manual
In mode Manual Zoom the scaling always stays constant, as it is preset in the number fields X-min /
X-max / Y-min / Y-max.

Auto
In mode Auto the optimal display is demanded in which all active curves can be displayed in their
completeness.

X-min / X-max / Y-min / Y-max
The present scaling of the graphic can be taken from this number field. These values may be edited
manually with manual zoom.

Navigation
You can move within the measurement curve graphic by using the 4 cursor buttons (up, down, right,
left) or the lens button in the navigation field.
The buttons represented a repeating key function:

Save Device Parameter
The data in the measurement program currently being processed (the program number is displayed in
the title bar) can be saved in a backup file. If the file already exists, you have the option of adding the
data from this measurement program to the file (‘supplement’) or ‘replace’ the file (the file is deleted
and a new one is created with this measurement program):
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Transmit
The data in the measurement program currently being processed (the program number is displayed in
the title bar) is transmitted to the device following a confirmation prompt and the dialog window is
closed.

Cancel
The dialog window is closed without any changes having been made to the device. If you would like
to the save the data first, click on the Save Device Parameter or Transmit buttons.

Note: As soon as you have changed at least one parameter of the Program dialog windows (Channel
Settings, Measuring Mode, Sensor Test, Evaluation Windows and Envelope, Switch Points or
Presentation) the state was set to not saved/transmitted.
You discard the changes if you cancel the Program dialog (with accepting the security message which
you can deactivate and if necessary activate in the General Settings – Presentation.
The changes you have made with respect to the program currently being processed (0-7) are only
transmitted to the device if you click on the Transmit button or save the changes using the Save
Device Parameter button.
Please note that only the data in the Program dialog windows is saved or transmitted when these
corresponding procedures are executed. These parameters are handled separately from the
Parameterize dialog window!
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Pass Window
The pass window is the most frequently used Window Type.
In this window type, the curve needs to run from the entry side to the exit side without passing through
any of the other windows.
A maximum of 3 pass windows can be assigned per measurement program.

Online Window
The online window (also referred to as the ”merge window”) is specially designed for injection and
joint operations. It checks to see that the joints are merged properly and not misaligned. In the former,
this is accompanied by a sharp power increase in the merge area. This then exits the top of the merge
window.
Online windows only check the positive run of the curve (from left to right).
A maximum of 1 online window per measurement program can be assigned.

Block Window
The Block Window monitors the block dimensions and strength of a compression connection, for
example. The curve needs to enter in the specified Entry side for this Window Type (Left, Right,
Upper, Lower except for Don’t care), but may not exit the window!
In an OK case, the curve may not exit the window – for this reason, the Exit side cannot be specified.
The block window only checks the positive run of the curve. As a result, the Pass direction cannot be
set.
A maximum of 1 block window per measurement program can be assigned.
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Offline / Online
Offline
Offline refers to the processing of device parameters from a backup file or newly created device
parameters without having a DIGIFORCE 9310 connected at the time.
These device parameters can be saved again as a backup file after being processed. If at least one
station is found in the device list, the parameters can also be directly transmitted to a station.

Online
Online refers to the reading of device parameters directly from a DIGIFORCE 9310. To do this, you
need to select a station from the device list and use the context menu (right mouse button) or click on
the Parameterize button to read the device parameters directly from the station.
These device parameters can be transmitted back to the same station after processing or can be saved
as a backup file.
This saved backup file can be transmitted to the station of your choice using the upload function.

Teach-In
Teach-In refers to the ”acclimation” or measuring of measurement data.
This function can be used in online operation for the lower and upper calibration values as well as the
reference point (Sensor Test).
Follow the messages that are displayed while carrying out the Teach-In.
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Laboratory Operation
[Measure -> Laboratory Operation]

You can access laboratory operations by selecting a station (if present) with which you would like to
work online from the device list. Now, click on the
‘Laboratory Operation’.

button or follow the menu path ‘Measure’ ->

You can read, display, measure, print and save the DIGIFORCE 9310 measurement data as a
measurement or export file. This file you can reloaded at any other time.

Read Measurement Data
Click on the Read Meas Data button to retrieve measurement data.
If the device does not contain any measurement data, a message to this effect appears.
The reading of measurement data can take several minutes if the interface parameter are not set
properly and if there is a large number of curve values.
As long as a data transfer is active a corresponding section Data Transfer appears.

Export Measurement Data
In order to save measurement data read from the DIGIFORCE 9310, click on the Export Meas Data
button. The data is saved according to the format specified in the General Settings. Change these
formats as necessary.
You can also specify the standard target directory for measurement files in the General Settings (Data
Storage).
The measurement file names are a combination of the date, time and serial number of the
DIGIFORCE 9310. In this way, the files can be clearly assigned.
Of course, you can rename files before saving them.
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Save
You can save the displayed measurement data in some special, only for DigiControl 9310 readable
format. For this please press button Save. With button Load you can display the measurement data you
saved any time before.
A Digital Signature was integrated in every saved file. A Digital Signature gives information about a
possible manipulation of the file.
You can also specify the standard target directory for measurement files in the General Settings (Data
Storage).

Load
With button Load you can display the complete measurement data you stored any time before with
button Save.
You can also specify the standard target directory for measurement files in the General Settings (Data
Storage).

Print Protocol
Click on the Print Protocol button in order to print the current measurement on the printer installed in
DigiControl.
The dialog for editing of additional informatios of the measurement appears.
After confirmation with Next the printer selection dialog appears.
Further informations about the print preview pleas click here.

Evaluation
After the measurement values are read from the DIGIFORCE 9310, you will receive a note pertaining
to the evaluation (OK/NOK/NIT). There are three formats available:
- Smiley:
green (OK), red (NOK), red (NIT)
- Text:
OK or NOK, NIT (NOK-Trend)
- Measurement curve:
Colour can be set specific to the evaluation.

Signature
You can see any information of the Digital Signature state if no Signature was found or the Signature
was invalid (for example by manipulation).
Please note that a Digital Signature is present from the DigiControl version 2003.1.0.

General
The minimum and maximum values (X/Y) for the current measurement are displayed in the Curve
Data tab page.

Windows
If evaluation windows were defined for the current measurement program, the settings are displayed in
the upper section and the results in the lower section.
If evaluation values doesn’t exist in the reffering controls “n. a.” appears.

Meas. Values
The individual curve measurement values are displayed in the Meas. Values tab page.
You can double-click on a measurement value list entry to trace individual measurement values in the
measurement curve graphic. The reference cursor appears automatically – you can deactivate this
using the right mouse button!
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You can scroll through the curve values in the measurement value list using the up and down keys on
the keyboard. The reference cursor follows the current respective value.
If you would like to switch the measurement curve display or adjust the colours, you can do this in the
General Settings - Presentation section.

Envelope
If the current measurement program contains an active Envelope (from DIGIFORCE Firmware
V200304) you can see an additional tab Envelope. If Trend tracking is active you can also find details
about it.

Zoom
Zoom is meant the scaling of the measurement graphic. You can switch the Zoom mode to Auto Zoom
or Manual.
Manual
If you want to edit the zoom coordinates by hand select Manual and enter the coordinates in the
coordinate value fields X-min, X-max, Y-min and Y-max.
Auto Zoom
If the scaling of the measurement graphic should be executed automatically if you load a measurement
file or read measurement data from device please set the control value to Auto Zoom.
You can perform an immediate auto zoom if you push the button Auto Zoom. This is independend of
the zoom settings Manual or Auto Zoom (Note: in the position Manual the existend coordinate values
get lost if necessary!).
X-min / X-max / Y-min / Y-max
You can always see the current scaling values in this coordinate value fields. In the manual Zoom
mode you can edit this values by hand.

Cursors
Two cursors are available for measurement: a reference cursor and a position cursor. You can use
these two measure the distances and points in the measurement curve graphic.
You can switch the cursor on or off as follows:
Reference cursor (Cursor 1):
Click with right mouse button
Position cursor (Cursor 2):
Click with left mouse button
You can adjust the Colors of the Cursors in the General Settings - Colors.

Navigation
You can move within the measurement curve graphic by using the 4 cursor buttons (up, down, right,
left) or the lens button in the navigation field. The buttons represented a repeating key function:

Capture the zoomed area with the mouse
Keep the [STRG]-key pressed, while you mark the part of the graphic to be enlarged in
rectangular form with the left mouse key. After you release the mouse key this part will be
displayed close-up in the graphic.
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Print-out Protocol
[Measure -> Laboratory Operation -> Print Protocol]
You can edit the following data before print-out:
-

Company (changeable in User Information)
Editor (changeable in User Information)
Description (will be saved for the next print-out with option save)
Remark (will be saved for the next print-out with option save)
Print-out Envelope Curves in the graphic *
Print-out Trend Curves in the graphic *

If you pressed the button Next the printer configuration dialog appears. There you can select if you
want to:
- Preview
- Print
- Export to PFD
Further informations about the Preview you can find here.

* = Available from DIGIFORCE 9310 Firmware V200304
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Selection of parameters for print-out
[Edit -> Parameter Print-out -> Load Parameter File -> … -> Print]

You can decide which programs (Program Number) you would like to print out device parameters
that you have loaded from a backup device parameter file. You can also print out the Basic Settings.
For the print-out you must select a printer in the General Settings – Printing.
After you have made your selection, confirm by clicking on the OK button.
Further informations about the Print Preview you can find here.
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Curve Array Print-out
[Parameterize Program (New, from File, online) -> Evaluation -> Curve Array Print-out]

If you want to print-out an Array of Curves which you have ever Measured (Teach-in Array of
Curves) please press the button Curve Array Print-out on the Evaluation Dialog.
Options for the print-out you can define at the General Settings.
Sample Preview:
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Print Preview

If the Preview dialog for the Measurement Protocols, Device Parameter, Statistics or Array of Curves
is active you can save this Preview directly as Preview File.
But this Preview File with the file extension *.LL could only be opened and displayed if DigiControl
9310 from version V2004.1.0 was installed on the system.
Normally the file size of this Preview Files was much more smaller than PDF files and they couldn’t
be changed or manipulated.

More Options at the Print Preview
Print current page…
If you want to print-out the currently displayed page press the button

To select another printer or change the printer settings press the button
button. The printer configuration dialog appears.

with the left mouse button.

with the right mouse

Print all pages…
If you want to print-out all available pages press the button

with the left mouse button.
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To select another printer or change the printer settings press the button
button. The printer configuration dialog appears.
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with the right mouse

Save As…
If you want to save the Preview as Preview File or as another file like PDF or graphic file press the
button

.

e-Mail (Send to…)
If you want to send the Preview as Preview File, PDF or graphic file per e-mail press the button
.
Then you can select the file type and with OK the system specified Mail program (if available) opened
and the file attached to the e-mail.
Exit Preview

To quit the Preview please press the button

.
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Upload (Backup File -> DIGIFORCE)
[Mark a Station in the device list -> File -> Upload]
Use this function in order to transmit the DIGIFORCE settings saved to a device parameter backup file
in DigiControl back to DIGIFORCE 9310.

button in the main dialog window or by selecting
You can call up this function by activating the
the entry Upload (Backup File –> DIGIFORCE) in the File main menu.
Select the backup file that you would like to send to the DIGIFORCE 9310.
The dialog always opens to theDigiControl 9310 subdirectory \Param. Select a file by doubleclicking on it or click on Open to transmit the device parameters from the file to the device.
Before the selected parameter backup file will be transferred you get a message if the file contains a
valid Digital Signature.
Please note that a Digital Signature is present from the DigiControl version 2003.1.0. Therefore you
get a message that no Digital Signature was found if you have selected a backup file which was
created with an older version of DigiControl 9310.
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Download (DIGIFORCE -> Backup File)
[Mark a Station in the device list -> File -> Download]
Backup refers to the saving of all device settings for a selected DIGIFORCE 9310 to a device
parameter backup file.
button in the main dialog window or by selecting
You can call up this function by activating the
the entry Download (DIGIFORCE -> Backup File) in the File main menu..
Please note that you first need to select a device in the device list, the device must be connected to the
interface and must be available. Otherwise, an error message will appear.
Select the path and name corresponding to the backup file that you would like to create using the
selected DIGIFORCE 9310.
The dialog always opens to the DigiControl 9310 subdirectory \Param. Select a file by doubleclicking on it or click on the Save button to generate the device parameter backup file.
A Digital Signature was integrated in every parameter backup file. A Digital Signature gives
information about a possible manipulation of the file.
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Common Download (Download of all DIGIFORCE into a separate
backup file)
[File -> Download of all DIGIFORCE into a separate backup file]
With a Common Download a backup file of every DIGIFORCE in the device list will be
automatically created.
DigiControl checks all DIGIFORCE devices in the device list before the Common Download starts.
They must be connected to the serial interface.
The Common Download was aborted with a message if some DIGIFORCE devices were not
reachable.
Please perform always a new device search if you want to start the Common Download with different
devices.
A separate directory will be created for the Common Downloads in the Device Parameter Storage
Directory with the name „Common“.
In the „Common“ directory the performed Common Downloads were stored in a separate subdirectory
with the following format:
<YYYY_MM_DD[-Index]>
If you perform more than one Common Downloads a day the Index increase.
A Digital Signature was integrated in every parameter backup file. A Digital Signature gives
information about a possible manipulation of the file.

Common Upload (Upload one backup file into all DIGIFORCE)
[File -> Upload one backup file into all DIGIFORCE]
With a Common Upload one backup file was transmitted automatically into every DIGIFORCE which
was listed in the device list.
DigiControl checks all DIGIFORCE devices in the device list before the Common Upload starts. They
must be connected to the serial interface.
The Common Upload was aborted with a message if some DIGIFORCE devices were not reachable.
Please perform always a new device search if you want to start the Common Upload with different
devices.
Please proceed with the Common Upload such as the simple Upload.
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General Settings
[Edit -> General Settings]
You can select from the following topics as tab pages in the General Settings dialog window.
You need to have the appropriate security authorisation in order to make any type of settings in the
program.

Interfaces
Interface configuration specifications for communicating with the DIGIFORCE 9310

International
Settings for the following parameters:
•
Program interface / Windows online help language
•
Number formatting.

Security
•
•

Password
User information

Data Storage
Selections of the following program directories:
•
Device parameter files path
•
Measurement data path
•
Laboratory Operation Protocol files path
•
Curve Array files path
•
Statistic files path

Backup
Take settings for Download and Upload of Backup files.

Output
Formatting specification for measurement export files. These can be processed further in Excel, for
example.

Printing
Setup of printing options.

Presentation
Options for graphical display and measurement curve line type selection.
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International
[Edit -> General Settings -> International]

Language
You can select the Program Language as well as the Online-Help Language in the International tab
page.
The country-specific setting (key number as well as description) of your Windows system is displayed
for information purposes (Language of the System).
This location defines various system characteristics such as formatting settings, for example.
You can check this setting on your computer by clicking on the Start button and then: Settings ->
System Setting -> Country Settings.
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Numbers
The decimal setting that applies to the program can be specified in the Number of Decimals field.
There are several options to choose from here.

The Decimal Separator entry describes the system-based formatting setting used within the program.

Click on the OK button to adopt these settings in the program.
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Data Storage
[Edit -> General Settings -> Storage]
In this dialog box, you select the standard directories for storing device parameters, measurement
protocols, Statistic Files and Curve Array files.

You have the option of selecting a directory for each storage type.
To change the path, click on the Change button. A dialog box then appears in which the directory can
be selected:
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Of course, the selected directory can also be located on another drive, or on a different computer or
server via the network.

Directories as well as saving options are available for the following storage types:

Device Parameter Settings
This directory contains all device parameter files that you can generate offline or with the connected
DIGIFORCE 9310 devices.
The following information can also be specified here:
•
Whether all programs (also unnamed programs) or only the unnamed programs are to be saved
(Save unnamed programs).
Note: Please note that the Download time required is extended as a result of these options!

Measurement Data Export
The generated measurement protocols are stored as predefined measurement data files in this path.
Please specify the data format of such files before creating them.

Laboratory Operation Protocols
The measurement protocol files in the laboratory operation mode are stored as special files in this
path.

Curve Array Files
When parameterizing a program, you can use the Teach-in (Measure) function to generate Curve of
Arrays. These can then be saved or loaded back into the program.
The start directory for these measurement curve graphics is specified here.
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Statistic Files
This is the file path for the Statistic Files. These can then be saved or loaded back into the program.

Click on the OK button to adopt these settings in the program.
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Interface
[Edit -> General Settings -> Interface]

Device Communication (DIGIFORCE 9310)
A physical connection between the interfaces of both components is required to permit communication
between the PC program DigiControl 9310 and DIGIFORCE 9310.
Compare the DIGIFORCE 9310 settings to those of the DigiControl 9310 and adjust them
correspondingly if necessary before establishing the connection.
Please be sure that you have not activated the menu ”RS232 + RS485” on the DIGIFORCE 9310
before carrying out the device search. Otherwise, the device setting is not yet activated.
For more information, consult the DIGIFORCE 9310 operating manual.

PC Interface
Select the PC COM interface used to connect the DIGIFORCE 9310 devices. Depending on the
operating system (Windows NT, Windows 2000...), these must already exist /be configured in the
system.

Blockcheck
Activate the blockcheck to avoid transmission errors.
This setting is only possible for data formats with 8 databits.

Baud Rate
Choose 57600 baud to achieve the highest transmission rate.
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Data Format
Data format setting for the interface connection used. Please remember that it is not possible to
activate the blockcheck for any setting with 7 databits!

RS 485 Operation
Here you can find details for the RS 485 operation.

Note: The standard values set for the DIGIFORCE 9310 upon delivery are marked with a small
star!
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Security
[Edit -> General Settings -> Security]

It is possible to set two different security levels in order to adapt the program to the user environment.
For example, it is possible to prevent the device from being reconfigured by selecting the highest
security level. It is then necessary to enter a password in order to change device parameters.
When setting up the device, it makes sense to select a lower security level (standard setting). In this
way, it is possible to transmit all parameters from the program to the device and make changes where
necessary.
Important note: The security level setting as well as the user information is user-specific and is
stored under the respective user name on the PC!
This means that the security level for a user needs to be set while is logged on to the PC under
his/her Windows logon name!

High Security Level (changes only with password)
You can make changes to the program or to device settings via the program only after entering the
valid password.

Low Security Level (changes after confirmation)
If you have made a change, a confirmation prompt informing you of the possible consequences
appears before the change is adopted. You can then decide whether you wish to execute the change or
cancel the action.
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It is not necessary to enter a password.

You will find additional information under the following points:

User information
Enter the information pertaining to the user or your company here.

Password
Information about entering and changing passwords (Change Settings ...).
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Password
It is necessary to enter the valid password in order to make entries for User.

Enter Password
Click on the Change Settings ... button and enter the current password in the dialog box that appears.

The standard password following program installation is 1234.

Change Password
To change the password, enter the password that is currently valid.
Now, select the Password field and enter the new password of your choice. The new password
becomes valid after you confirm your selection by clicking on the Yes button.

Operation Manuel

PC-Software DigiControl 9310

Page 74 to 128

User Information
[Edit -> General Settings -> Security]

In order to make changes to the User Information or Security, you first need to enter the program
password.
Entries can now be made in the fields and you can edit the User Information.

Name
After you have entered the password, enter your name or the name of the inspector working with the
program in this field.

Company
After you have entered the password, enter the name of your company in this field.

Password
You cannot see the password – only the number of characters you have entered. Only asterisks are
displayed.
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Actions
[Edit -> General Settings -> Actions]

Under Actions Procedures will be defined which were executed after every measurement.
Each entry in the list matches one action which optional was executed only at a especialy evaluation
result or sequence.
With option Selection you can activated the Plug-In or deactivate for a special time.
With Properties the separate dialog Action Settings appears. There you can setup the action details.
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Colors
[Edit -> General Settings -> Colors]

Colour Settings
You can select the following colours for the presentation of measurement curve graphics:
-

Measurement curve OK (valuation OK)
Measurement curve NOK (valuation not OK)
The old Measurement curves (only with option Array of Curves in Program-Measure)
Reference cursor 1
Position cursor 2
Background
Grid line colour
Evaluation window
Reference Curve
Reference Min-/Max-Curves
Envelope Curves
Trend Tracking Curves

0

You can return to the original settings by clicking on the Standard Settings button.
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Presentation
[Edit -> General Settings -> Presentation]

Measurement Curve Presentation
You can select Line or Dots in the Measurement Curve Presentation as well as the line width. This
has the advantage in case you want to watch outliers, for example, but the line display influences the
curve slope.
You can edit the value for option Measure Curve Count Quantity during Teach-in (Measure) from 0
to the maximum value. With a value >1 you receive a curve array when you Teach-in (Measure).

Messages
With this option you can activate the displaying of the following messages if necessary:
- Security message if DigiControl 9310 communicates with a device which have a newer software
version and new commands and DigiControl 9310 didn’t know all commands. In this case you
should ask for an DigiControl 9310 update.
- Security message if you Cancel changes in the Parameterize or Program Dialog.
You can return to the original settings by clicking on the Standard Settings button.

Operation Manuel

PC-Software DigiControl 9310

Page 78 to 128

Backup
[Edit -> General Settings -> Backup]

Download Settings
This setting decides whether all programs (also no named) or only the renamed programs should be
saved during device backups (Save no-named Programs).
Note: Please acknowledge that the activation of this option prolongs the transfer time of a
Downloads!

Upload Backup file into device (from DIGIFORCE firmware V200304)
Reset to Base (Reset)
During Upload of a backup file all Statistic Values were reset to the base values. Also the values for
the trend tracking can be optionally reset if Trend is active.
Values from File
If statistical values are present in the backup file the complete statistics and trend tracking
configuration (if active) can be transmitted to the replacement device. This feature is also useful for
applications with more than 8 active measurement programs per DIGIFORCE®.
No Changes
The statistic of a DIGIFORCE® remains unchanged during the Upload of a backup file.
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Printing
[Edit -> General Settings -> Printing]

Printer Settings
All systems printers are listed here. The standard setting is preset on the standard printer which is used
for protocol printouts.
If you prefer to use a different printer for the DigiControl 9310 you should select it at this point.

Bitmap File for Protocols
For printouts of Measurement Protocols, Statistic Files, Curve Array Files and Device Parameter
Settings (Backup files) you may incorporate your own logo symbol on the documents.
Kindly select a bitmap file with adequate resoluation with Change.
In case you Remove this later on, the standard burster logo is incorporated again.
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Measurement Mode
[Edit -> General Settings -> Measurement Mode]

Settings
Maximum number of curves in the curve array
If the Details -> Last Measurement curve is active during the Measuring mode the number of curves is
equal to this value. The value range is from 1 au to 100. But please note that the processing of several
curves in the graphic needs more and more time. At time critical applications the number of curves
should be very little.
Watch hard disk capacity
If you want to prevent a crash of your operating system because of an insufficient hard disk space you
can edit the value for a warning message and the abortion of the measurement mode.
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RS 485 Operation
You can connect several DIGIFORCE 9310 with help of appropriate connection wires and a RS 485 –
RS 232 converter IC-485S (burster 9900-K339) to a computer interface.
Do only apply a 4 wire full duplex connection!
Use the following figure for wiring and for the converter setting:
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Measure (Teach-in Array of Curves)
The array of curves can be recorded for 20 measurements. The exact quantity of max. measurement
curves can be set under General Settings – Presentation.
With the help of this array of curves, a new envelope could be generated, for example, or the
evaluation windows could be placed. Furthermore, the curve array may be printed out.
The curve array can be saved to a file eventually and loaded again later on.
Please note: During the curve array measurements the statistical counter of the DIGIFORCE® is
deactivated.

Measure
The animation of the above displayed graphic shows that measurement is active.
Active
The measurement curve is accepted for calculation in the dialog Parameterize Program if the related
line is checked in the list. If the check box is deactivated, the measurement would be erased
beforehand.
During the capture of measurement curves the resulting files are always recorded from top to bottom
(until max. quantity of measurement curves is reached) and the previous curves are simply overwritten
in the list. After this the checkbox is activated again.
Meas. Val.
Quantity of Measurement Values of the corresponding measurement in the list.
Description
To add a certain Description to a measurement curve you simply need to enter it in the text field
positioned below the list. However please acknowledge that the corresponding measurement curve
must be checked in the list.
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Result
Display of the evaluation result of the corresponding measurement.
Pause
To halt the measurement mode for a short time and eventually effect changes in the configuration of
the DIGIFORCE® the key Pause can be used. Additionally, this activates the statistics counter in the
DIGIFORCE®.
Delete
Press this key to delete all measurement curve recordings in the list and to start a new.

Zoom
The scaling of the measurement curves’ graphic is meant by Zoom. You have the choice of Manual,
Auto and from DIGIFORCE.
Manual
In mode Manual Zoom the scaling always stays constant, as it is preset in the number fields X-min /
X-max / Y-min / Y-max.
Auto
In mode Auto the optimal display is demanded in which all active curves can be displayed in their
completeness.
From DIGIFORCE
Select this option if you intend to stay with the graphic resolution of the DIGIFORCE®.
X-min / X-max / Y-min / Y-max
The present scaling of the graphic can be taken from these number fields. In Manual Zoom these
values are editable and can be changed directly by input manually.

Capture the zoomed area with the mouse
Keep the [STRG]-key pressed, while you mark the part of the graphic to be enlarged in
rectangular form with the left mouse key. After you release the mouse key this part will be
displayed close-up in the graphic.

Accept
To Accept the recorded measurement curves please press this key. Please note that the previously
recorded curve array might be overwritten in the dialog Parameterize Program if these have not been
saved, yet.

Cancel
If you want to neglect the captured measurement curves you have to push the button Cancel.
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Envelope
General
The envelope curve is an additional evaluation method. The measurement curve needs to run through
the envelope curve band without passing the upper and lower limits in order to identify the produced
as OK-part
Creation of an envelope curve:
The reference curves are created with the help of a bundle of measurement curves. This results in the
calculation of a curve with averaged values which is to be considered as the actual reference curve, as
well as a minimum and maximum reference curve which represents the positive and negative limit to
the reference curve.
The Min-/Max-reference curves are wrapped by the envelope curve band. This can be widened by the
Delta-Y value and by means of the X limits, the start and end value of the tolerance band can be
determined.

Display options
It can be very helpful for clarity reasons to hide/display certain curve slopes while working on the
envelope curve configuration. This is done with the display options. The configuration of the related
curve colour can be done in General Settings – Colors can be done in the display menu; the way to
display the curves (bold or style) can be done in GeneralSettings – Presentation.
Show Array of Curves
If you have set the dialog program parameters to load a curve bundle from a file or measure the same
you may switch it invisible / visible.

Show Reference Curve
Select this option if the reference curve should be displayed.
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Show Min/Max Reference Curves
The selection of this option decides whether the min/max reference curves was displayed or not.
The display can be selected as curve line / curve band in the GeneralSettings – Presentation.
Show Envelope Curves
Select this option if the envelope curves should be displayed.
The selection of display as curve line / curve band can be done in the GeneralSettings – Presentation.
Show Trend Curves
This option defines if the trend curves was displayed.
The selection of display as curve line / curve band can be done in the GeneralSettings – Presentation.

Zoom
The zoom is equivalent to the scaling of the measurement curve graphic. A manual and automatic
mode are offered.
Manual
The scaling that was configured in the number fields X-min / X-max / Y-min / Y-max when mode
Manual Zoom is active.
Auto
The mode Auto results in an optimal display in which all active curve types are completely shown.
Please note that in this mode the even with use of navigation the auto zoom is done with the changing
of parameters.
X-min / X-max / Y-min / Y-max
The present scaling of the graphic can be taken from this number field. These values may be edited
manually with manual zoom.

Capture the zoomed area with the mouse
Keep the [STRG]-key pressed, while you mark the part of the graphic to be enlarged in rectangular
form with the left mouse key. After you release the mouse key this part will be displayed close-up in
the graphic.

Navigation
The partial display and resolution of the graphic are changed with the help of navigation. When you
keep the navigation key pressed the corresponding function is repeated until you release it.

Accept
To accept the changes in the envelope curve configuration please press this key.
IMPORTANT! These settings are transmitted to the device only after you press the key accept resp.
Save Program Settings in the dialog Parameterize Programs!

Cancel
Press this key if you intend to reject the changes made in the envelope curve configuration.
The previous program settings in the dialog Parameterize Programs are consequently restored.
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Envelope Parameter
To learn more about the Envelope Evaluation please click here.

Envelope
On / Off
Switch the Envelope function generally on or off at this control.
X-min / X-max
Determine the start and end of the envelope curve on the X-axis in this field. The limiting values
which are not to be passed can be found under X-min and X-max in brackets.
Delta-Y
This value defines the Delta-Y value which is wrapped around the forward or backward moving curve
of the curve.

Trend Curve
On / Off
Here you switch on / off the function Trend curve / Trend tracking.
Delta Trend
The Delta Trend value indicates the distance from the envelope curve limits to the trend curve limits.
These set trend limits must not be reached by the envelope curve in measurement mode – otherwise
the measurement is valued as NOK with the trend function switched on.
Weighting
The weighting defines the influence of a measurement on the tracking of the envelope curve within the
trend limits. A weighting of _ e.g. has the greatest and 1/256 the smallest influence on the present
measurement curve on the trend.
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Edit Envelope

Edit Envelope
Off
You need to select the upper curve or lower curve.in order to edit the envelope curve manually.
Upper curve
To edit the curve slope of the upper reference curve (max-reference curve) graphically you need to
switch this option on. Then you may draw the required curve slope freehandedly while keeping the left
mouse key pressed. You should proceed as slow as possible from left to right so that as many points as
possible are captured for the calculations.
Important: Stay always above the reference curve since you are working on the upper (max-)
reference curve!
Lower curve
To edit the curve slope of the lower reference curve (min-reference curve) graphically you need to
switch this option on. Then you may draw the required curve slope freehandedly while keeping the left
mouse key pressed. You should proceed as slow as possible from left to right so that as many points as
possible are captured for the calculations.
Important: Stay always below the reference curve since you are working on the lower (min-)
reference curve!
Undo
The graphical editing of the envelope curve can be undone pressing the key Undo in a maximum 10
steps.
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Default Initializing
[Edit -> Default Initializing]
Select Default Initializing in the menu Edit. The following dialog opens up:

With Default Initializing, all parameters of the selected measurement program are reset. (Initialization
of standard values). Then the program is in the original condition when delivered.
Important Note: Kindly acknowledge that the complete configuration of the selected measurement
program is lost if you do the Default Initialization. Eventually you should create a Backup-Datei
ahead of time.
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Edit Statistic
[Edit -> Statistic]
Select Statistic in menu Edit – the following dialog will open up:

Read Statistic
Press this button in order to readout the statistics of all measurement programs of a DIGIFORCE®.
According to the configuration of the measurement program you receive the available statistical data.
These can be reset by Perform Reset.

Load
Statistical data that was previously saved to a statistics file can later on be loaded and e.g. printed out.

Save
Statistical data that was readout from the DIGIFORCE® previously can be saved under an editable
statistic file and loaded again and printed, for example, at a later point in time.

Print
In order to print the statistical data, you need to read them out from the DIGIFORCE® or loaded from
a statistics file. All available statistics data will be printed from the DIGIFORCE®:
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Statistic Reset
[Edit -> Statistic Reset]
After selecting Statistic Reset in menu Edit, the following dialog will open up:

Every measurement program contains the following statistical data:
- Piece counter
- NOK-counter
- NOK window statistics for window 1 to 3
- NOK envelope curve statistics (from DIGIFORCE® firmware V200304)
- NOK Trend statistics (from DIGIFORCE firmware V200304)
The a.m. statistics data of the selected measurement programs will be reset to ‚0’ with a statistical
reset.
Important note: Please acknowledge the fact that a Reset erases all statistical data of the selected
measurement program! Kindly consider to create a Backup-File eventually, containing the complete
device settings or save the present statistical data to a statistics file.
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Export

It is possible to export measurement data immediately during measurements or later on into other
formats such as Excel. For later transfer it is possible to select the measurement protocols by searching
for specified criteria and then export only these ones. The corresponding plug-ins are to be used for
this process.

Installed Plug-Ins
If you have already activated the Plug-Ins in the presettings then they will appear in the box „Installed
Plug-Ins“. Select the right one for your requirements.

Special Plug-In
If you do not want to use the pre-installed Plug-Ins then please use the menu point „Special Plug-In“.

File Selection
To export only selected protocols please make your choice from the protocol list with the help of the
left mouse button, the CTRL and SHIFT keys. For export please choose the option „Marked
protocols“.
Only these selected measurement protocols are then exported.
If you wish to export all measurement protocols from the list then choose „All protocols“.

Details
Here you find the indications on the applied plug-ins such as e.g.: the Name or the Version.
For most Plug-Ins you may configure the content index of result files (e.g. Excel) by selecting the
valid path in the menu „special output directory“.
Complexe plug-ins offer the possibility to effect a plug-in internal setup.
For further details please refer to Description of the plug-in interface.
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Search Group Protocols
[Measure -> Search and edit Measurement Protocols -> Search Group Protocols]
In the upper part of the table, the opened group protocols are displayed. Every group protocol
corresponds to minimum one and maximum 32 group members whose protocols are listed in the lower
part of the table.

For every marked (blue background) entry in the upper group protocol list the corresponding single
protocols of all group members appear. These can be available as protocol files. However, only those
protocol files can be opened (Open all single protocols) which actually have a file name in the column
„file name”. If there is no entry in this column then the protocol files were not saved (refer to
presettings Actions).
If a group protocol file has been manipulated later on then it becomes obvious with the entry „Data
checksum NOK“ in the corresponding group protocol.
For printout of the group protocols as a list or single pages press the buttom Printout group
protocols....
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Print group protocols
[Open protocols -> Search for group protocols -> Open -> Print group protocols]

Selection
Prior to printing group protocols you have to decide if All (all in the list) or only Selected Protocols
should be printed. This is done in the print dialog. For selection of protocols please use the usual
Windows methods: Multiple group protocols can be marked at the same time by marking the first and
the last protocol in a coherent list. Single protocols can be selected from non-conherent lists by
keeping the CTRL-key pushed down.

Print Options
Page
The group protocol is printed as a single page. The group’s total result as well as the corresponding
single results of the group members are listed therein. Optionally, the present worker’s name and a
description (not with the list) can be included. If this is not wanted by the user he must erase these
fields.

List
An overview of the selected group protocols is printed in list form. On each protocol page there are
max. 40 group results listed in 40 corresponding lines.
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Start Measurement Mode
[Measure -> Start Measurement Mode]

Basically, there are two operation modes for measurement:

Simple measurement mode
All DIGIFORCE listed in the group list are asked for a new, valid measurement result in an everrepeating slope. Every new measurement result may be transferred to the PC according to the
definition of the parameters of a station, depending on the configuration, saved as per specific rules
and eventually effective plug-ins.

Measurement mode with device group
The specifications of this operation mode is basically the same as for single measurement mode.
However, one or more stations can form one device group and the overlapping group result needs to
be displayed.
Details on this matter can be found at definition device group.

General
During the measurement mode you may choose the device whose measurement results (result,
quantity measurement values, part no., etc.) you wish to display via the buttons displayed on the top of
the menu.
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Details
If the function Details is activated you will see the following tabs, depending on the operation mode:
StatisticTime (1)
An OK/NOK statistic is shown over a complete day (24 hours) for one station.
When a new day begins, the statistic starts anew during the measurement operation.
The display of the statistic bars can be side by side or one upon the other.
Statistics device group (2)
In this statistic, the OK/NOK-share of all group members of one device group is shown. Further
information are available at Device Group Statistic.
Last measurement curve (1)+(2)
If the measurement curves are included for data collection for the corresponding station in the menu
Properties -> Measmode you can see here the measurement curve(s) from this station.
Optionally, the creation of a curve bundle can be activated in General Settings -> Measmode.
However, please note that the graphical preparation, especially for the curve bundle, is an extra strain
on the system and enlarges the time cycle for data transfer considerably.
Therefore, the function last measurement curve should only be activated for non-critical processes and
test phases in relation to the processing time.
Actions and data capture(1)+(2)
Description of data capture informs about the data which is captured for the evaluation result, i.e. the
data that is actually transferred from the device to the PC.
Action description informs about what happens to the previously captured data. For example, the
execution of a concrete plug-in (e.g. EXCEL statistics) could be started, depending on the evaluation
results. The pre-condition for this is always that Action Protocol File has been chosen.
Messages
Transfer errors or other important messages could be examples for information being listed in this
table. The status line will inform you accordingly about the quantity of messages as well as a
corresponding warning note.

Miscellaneous
•

•

If you have the configuration software 9310-P101 you can test the program module production
mode for maximum 3 minutes. It will be terminated automatically thereafter.
The setting of all visible dialogs is saved when closing the program and restored when restarting
it.

Important notes
• Please consider the Ready-Signale of all connected DIGIFORCEs during measurement mode!
Otherwise, an undefined start of the device caused by the PLC may lead to unwanted loss of data!
The data transfer is interrupted immediately upon START!
(1)= Device related
(2)= Group related
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Automatic start of measurement mode
Follow the steps thereafter mentioned in order to set the DigiControl 9310 to measurement mode
automatically upon start-up of the PC:
- Create a link of DigiControl 9310 in the autostart directory of the user profile in Windows:

- Click the right mouse button on the link and select the settings. Edit the field „target“ by entering a
blank sign and a plus sign after the high comma at the end of the link path.
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After this change, the DigiControl will automatically be set to measurement mode when the autostart
of the selected user is executed.
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Action Settings
[Properties -> Actions -> Properties]

You have the possibility to save the transmitted measurement data and eventually work on it with the
help of a Plug-In.

Add...
To add special plug-ins to the actions chosen in General you have to press Add. The following file
selection dialog allows the selection of the suitable plug-ins.

Remove
Using this button will remove the entered Plug-In from the list again.

Selection
With the help of this button it is determined which evaluation result shall cause the selected action.

Sequence
The sequence indicates after how many measurements the selected action should be executed again.
Example:
Entry 1: Selection OK / Save Protocol file / Sequence = 5
Entry 2: Selection NOK / Save Protocol file / Sequence = 2
Entry 3: Selection OK / Save Protocol file / Sequence = 10 / Plug-In „Curve.dll“
This setting leads to the execution of entry 1 and 2 for the first OK measurement and entry 2 for the
first NOK measurement result.
Therefore, the 6th OK measurement will start the action in entry 1 (i.e. 5 OK measurements later), the
3rd OK measurement starts the action in entry 2 (i.e. 2 OK measurements later) and the 11th
measurement starts the action in entry 3 (i.e. 10 OK measurements later). Additionally, the Plug-In
„Curve.dll“ is executed with activated entry 3.
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Protocol file
The protocol file is activated for saving as standard since otherwise no recording of the measurement
data could take place and further processing with Plug-Ins would not be possible!
Important note! Measurement data that are not recorded (and therefore are not present as protocols)
cannot be processed (e.g. with a plug-in) later on, either. You should consider this in time if you plan
to evaluate Measurement Data or make a measurement data export via Plug-In. Make the right
configuration under Properties in measurement mode in order to transfer and record the correct
measurement data!

Operation Manuel

PC-Software DigiControl 9310

Page 101 to 128

Plug-Ins
Two Excel plug-ins are included in the scope of delivery.

Curve.dll
The measurement data of respectively one protocol file is saved to respectively one Excel file. Therein
are included all measurement data which were actually recorded.
The Excel file is found in the same directory as the protocol file.
Under Properties you may select the measurement data to be transferred in the automatic measurement
mode.

Statistic.dll
Significant data such as e.g. the curve’s entry and exit values for the evaluation windows are saved to
an Excel statistic file with the help of this plug-in. If the part or station change a new file will be
produced! In each line there will be all the values recorded from DIGIFORCE which are related to one
press-in process or one part. Every column is corresponding to one characteristic, e.g. the scattering of
the block force could be watched for many thousand parts.
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Plug-in interface description
The description of the plug-in interfaces is yet under process and will be part of a future release of
DigiControl!

Ready-Mode
The need of documentation on measurement results for press-fitting and joint assembly processes
becomes more apparent. This might be necessary only for the test operation period or must be done
without a break for traceability and verification reasons. However, this requires securing of all
measurement data. Otherwise, a manufactured part without a measurement protocol might be
worthless!
The DIGIFORCE® 9310 records only the measurement results of the preceding press-fit in process. If
the device is started again these values will be overwritten by new values. The old values are lost
irretrievably. For this reason, these values have to be transferred via the serial interface in the cycle
break between the press-fit in processes. A restart of the DIGIFORCE must be avoided by all means
during this period of time. How is this achieved? How does the system control know about the
presently active data transfer and that no new press-fit in process must be started at this point?
The decisive criteria for this is the DIGIFORCE-signal READY. If READY=1 the next machine cycle
can follow whereas with READY=0 the system must wait! Quite simple! READY is usually only
effected by the status of the DIGIFORCE device. If READY=1, the device is finished with
measurement and evaluation and ready for the next measurement process. If READY=0, the
DIGIFORCE is still working on either MEASUREMENT or EVALUATION.
A special case, the so called READY-Mode=PC-CONTROLLED, makes READY depending on
another condition. If DIGIFORCE is still in the process of DATA TRANSFER, then READY can
remain at Zero until the Master (PC) has sent the command „fr“ (for READY release) to the
DIGIFORCE (see pic. 1).
To give a more detailed view:
At the beginning, the DIGIFORCE is in the so called READY-Mode “NORMAL” (see pic. 1). The
READY-Signal is solely controlled by the device status! The serial communication does not affect the
signal at this point!
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In order to transfer measurement data without any breaks or disturbances, the creation of the READYSignal must be handled by the PC. The PC switches the DIGIFORCE to READY-Mode „PCCONTROLLED“ by sending the command „sr“ (the „relay“ is in the lower position as in the scheme
of pic. 2). READY is therefore depending on another condition which is called READY-Release. This
is given by the PC only after receipt of all required data via the interface. Then it sends the command
“rf” and thus releases the READY-Signal again. If the DIGIFORCE-Status allows it, READY will go
to “1” now. The PLC can release the next machine cycle and START the DIGIFORCE anew.
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DIGIFORCE is generally reset to READY-Mode „NORMAL“ and the READY-Release is reset to
“0” with every power-up.
What would happen if the PC freezes?
It is an eligible question to ask what would happen if the PC freezes after having set the DIGIFORCE
into the READY-Mode „PC-CONTROLLED“, but prior to the READY-Release with the rfcommand, e.g. during the data transfer? Would the complete system freeze in consequence?
Not necessarily! However, if the PLC takes care only of the READY-Signal this would become true.
The system goes down! The professional PLC-programmer would integrate a TIME-OUT or
WATCHDOG into his programming to avoid such situations. When the time for READY has passed
the system would go to “Fault” if the measurement data collection must be effected by all means. If
the mass production is more important, the READY is ignored, the DIGIFORCE restarts and
eventually sends a warning message! That’s it!
After the problem has been solved and the PC was restarted the active program forces the
DIGIFORCE to go to READY-Mode „PC-CONTROLLED“ again.

The WINDOWs-software DigiControl 9310-P100 of burster supports the
previously described READY-Mode!
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Licencing 9310-P100
[Measure -> Start Measurement Mode...]

There are two software versions:
9310-P101
9310-P100

Basic software for configuration, backup and laboratory operation.
like 9310-P101 with automatic measurement mode in addition.

The automatic measurement mode can be tested in the basic software 9310-P101 for 3 minutes each
time.
If you are in possession of the basic software 9310-P101, you may always upgrade to the full version
9310-P100. You would be sent a product key on which we will register you as authorized user.
For questions on the upgrade please contact Mr. Bräuer at e-mail Klaus.Braeuer@burster.de or at
direct extension +49-7224-645-51.
Support for the measurement mode will be given only if you are in possession of a valid product key.

User
Please enter the name on which the software shall be registered. Kindly inform us this name for
support querries or as reference to the product key.

Product key
Please enter the 20 digit product key in the provided fields.
There is no differentiation between CAPITAL letters and small letters.
Kindly press the key Accept to confirm the product key and to release the version 9310-P100.

Test 3 minutes
If you are in possession of the basic software 9310-P101 you may test the automatic measurement
mode for maximum 3 minutes.
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Control communication
The DigiControl 9310 can be part of a Control Communication via the 2nd COM Interface. This
might be necessary e.g. to start or stop the measurement mode or to switch from one measurement
program to the next or even transfer complete device parameter files to a station. The implemented
commands are described thereafter.
Please note the following information:
•
The brackets < / > only serve for segregation of the user and are not indicated.

Commands for an active device group:
Command

Command reference

Description

SRA <Note>
GRA
SNA <counter number>
GNA
SP1A <Value>
GP1A
SP2A <Value>
GP2A
SBA <Value>
GBA
SCA <Value>
GCA

SetRemarkGroupA
GetRemarkGroupA
SetNumberSerialGroupA
GetNumberSerialGroupA
SetParameter1GroupA
GetParameter1GroupA
SetParameter2GroupA
GetParameter2GroupA
SetBatchGroupA
GetBatchGroupA
SetComponentNameGroupA
GetComponentNameGroupA

To set the remarks on the device group
To query remarks on the device group
To set new Part-No. counter numbers on the device group.
To query the present Part-No. counter number from the device group
Set Part-No. %1 of the device group
Query Part-No. %1 of the device group
Set Part-No. %2 of the device group
Query Part-No. %2 of the device group
Sent and activate manual charge designation of device group
Query manual charge designation of device group
Set component name of the device group
Query component name of the device group

General commands:
Command

Command reference

Description

SM
GM
SP <Address> <MP-No.>

SetMode
GetMode
SetProgram

Set status on measurement mode
Query status of production mode

GP <Address>

GetProgram

SN <Address> <Counter no.>
GN <Address>
SP1 <Address> <Value>
GP1 <Address>
SP2 <Address> <Value>
GP2 <Address>
SB <Address> <Charge>
GB <Address>
SR <Address> <Remark>
GR <Address>
UF <Address> <Data path>

SetNumberSerial
GetNumberSerial
SetParameter1
GetParameter1
SetParameter2
GetParameter2
SetBatch
GetBatch
SetRemark
GetRemark
UploadFile

Switch measurement program of station

*

*

Query program number of station
Set new Part-No. counter number of station
Query present Part-No. counter number of station
Set Part-No. %1 of station
Query Part-No. %1 of station
Set Part-No. %2 of station
Query Part-No. %2 of station
Rename manual charge designation of station
Query manual charge designation of station
Set remarks on station
Query remarks on station
Transfer backup file to station

*

* = This functions only may be executed if the measurement mode is not active!

Parameter of commands GM/SM:
Parameter value

Description

-1
0
1
2

Measurement mode off
Under process
Measurement mode on
Measurement mode stopped

Parameter spontaneous message:
Parameter value

Command reference

@-1
@0
@1
@2
@3 <Addess program result>
@4
@5
@6
@10

DigiControlExit
DigiControl stopped
DigiControlStartedStandard DigiControl (standard) started
DigiControlStartedPlus
DigiControl PLUS started
UploadFileReady
Upload finished
MeasurementResultAvailable Measurement result (Address, program and result)
MeasurementStateOff
Switch off Measurement Mode
MeasurementStatePaused Measurement Mode paused
MeasurementStateOn
Switch on Measurement Mode
GroupResultAvailable
Group result available

Description
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Example of a PLC-control communication application
•

Recording of measurement data with the production serial number supplied by a PLC with
DigiControl 9310 in automatic measurement mode:
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Search for protocols
[Measure -> Search and edit measurement protocols...]
There are the following ways to look for measurement protocols that have been generated with the
automatic measurement mode:

Search measurement protocols with the assistant
Allows the automatic search for single measurement protocols with the help of filters such as e.g.
evaluation result, measurement program, time, station name, etc. within the FILE data directory.

Search group protocols with the assistant
Allows the automatic search of group measurement protocols with the help of filters such as group
result, date, charge, part-no. or component within the FILE data directory.

Manual selection of single measurement or group protocols
Listing of single and group measurement protocols in manually selected directories.
No filter can be set here.
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Search Measurement Protocols
[Measure -> Search and edit Measurement Protocols-> Search Measurement Protocols]

You search the single recorded measurement protocols that have been recorded during measurement
mode with the following filter criteria with this function:
All parameters have the wildcard sign * as default setting which actually deactivates the filter. If the
filter is only part of the complete reference you are looking for we recommend the use of the wildcard
sign [*] in front and after the filter.

Component
The name for the component was determined in the Properties of station and specific protocols with
this name can be found here. The component name should generally be identical with the name given
to the corresponding measurement program. Try to use plausible designations to enable easier
identification of the component later on.

Charge
The name of the charge was determined in the Properties of station and specific protocols with this
name can be found here. A charge usually refers to a certain period in time.

Part-no.
Here you can search for specific part-numbers (Serial nos.). The Part-no. corresponds to a running
counter which is synchronized to the charge or the component resp. is manually changed. In the easiest
case, the counter refers to the pieces counter in the DIGIFORCE. Optional is the presetting for
measurement mode where an additional parameter %1 resp. %2 can be placed before and after the
counter number (e.g. in device list and Properties Measurement Mode). Please note that every counter
number should exist only once since otherwise the protocols cannot be identified indisputable.
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MP-No.
This parameter informs the used numerical measurement program in the DIGIFORCE 9310.

MP-Name
The measurement program name is usually identical to the component name. Plausible designations
shall be preferred.

Date
Select the correct, predefined period of time. The time filter is deactivated and all measurement
protocols are searched with the setting on „any date”.
All other entries include specific dates or periods of time for the search.
To define the date yourself you have to select a given date and set the parameter in front of date to
“before” and “after” with the help of the date selection dialog which will appear when clicking on the
corresponding field or simply overwrite the displayed date.

Result
To select only OK or NOK parts please choose the corresponding evaluation result. The default setting
includes all measurement protocols, non-depending of the evaluation result.

Station name / DIGIFORCE-SN / Name in the group
According to the necessary data hierarchy you may select various references to the corresponding
DIGIFORCE.
- The most definite one is the parameter DIGIFORCE-SN. It corresponds to the unique serial number
of the DIGIFORCE.
- If the DIGIFORCE(s) need to be exchanged during production (for whatever reason), the Serial
Number of the station changes inevitably. Then the Station name must be used for the search. It has to
be assigned to for every device change or after new installations of a DIGIFORCE as follows:
After a double click on the corresponding DIGIFORCE in the device list you will reach the
corresponding menu (see below!). Please enter now the correct station name. This is transmitted to the
DIGIFORCE when exiting the menu and will appear under GENERAL SETTINGS -> INFO ->
STATION.
- If you e.g. work only with one DIGIFORCE 9310 which appears twice in the group list then this
DIGIFORCE will take care of controlling two different production processes. This could be
distinguished by a different Name in the group.

Search
In order to start searching you have to press the button Search.
During the search process a progress dialog appears in which the search can be stopped at any time.
The search results listed therein remain even if the search is interrupted.
Furthermore, the maximum quantity of measurement protocols is shown without recognition of the
filter definition.

Another path
Please press Another path.... in order to define another path for the search.
A dialog for directory selection appears. Please note, however, that it is always the DATA-file
directory which is selected as directory and not a sub directory included therein, based on the program
related data storage structure!

Standard path
To return to the default file directory please press the following button:
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Open all protocols
With an activated option all indicated measurement protocols are taken over into the dialog field
whereas a deactivated option will cause containing of only the marked measurement protocols.

Sorting
In order to sort the listed measurement protocols after a search, simply click on the column top after
which the list is supposed to be sorted.
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Search Group Protocols
[Measure -> Search and edit Measurement Protocols-> Search Group Protocols]

This function allows you to find specific group measurement protocols recorded during measurement
mode with the following search criteria.
All parameters have the wildcard sign * as default setting which actually deactivates the filter. If the
filter is only part of the complete reference you are looking for we recommend the use of the wildcard
sign [*] in front and after the filter.

Component
The name for the component was determined in the Properties of station and specific protocols with
this name can be found here. The component name should generally be identical with the name given
to the corresponding measurement program. Try to use plausible designations to enable easier
identification of the component later on.

Charge
The name of the charge was determined in the Properties of station and specific protocols with this
name can be found here. A charge usually refers to a certain period in time.

Part-no.
Here you can search for specific part-numbers (Serial nos.). The Part-no. corresponds to a running
counter which is synchronized to the charge or the component resp. is manually changed. In the easiest
case, the counter refers to the pieces counter in the DIGIFORCE. Optional is the presetting for
measurement mode where an additional parameter %1 resp. %2 can be placed before and after the
counter number (e.g. in device list and Properties Measurement Mode). Please note that every counter
number should exist only once since otherwise the protocols cannot be identified indisputable.
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Date
Select the correct, predefined period of time. The time filter is deactivated and all measurement
protocols are searched with the setting on „any date”.
All other entries include specific dates or periods of time for the search.
To define the date yourself you have to select a given date and set the parameter in front of date to
“before” and “after” with the help of the date selection dialog which will appear when clicking on the
corresponding field or simply overwrite the displayed date.

From/To
To freely define a period of time please select the correct entry in the field Date in advance (except for
„any date“) and set the parameter „From“ and „To“ with the help of the data selection dialog.

Result
To select only OK or NOK parts please choose the corresponding evaluation result. The default setting
includes all measurement protocols, non-depending of the evaluation result.

Search
In order to start searching you have to press the button Search.
During the search process a progress dialog appears in which the search can be stopped at any time.
The search results listed therein remain even if the search is interrupted.
Furthermore, the maximum quantity of measurement protocols is shown without recognition of the
filter definition.

Another path
Please press Another path.... in order to define another path for the search.
A dialog for directory selection appears. Please note, however, that it is always the DATA-file
directory which is selected as directory and not a sub directory included therein, based on the program
related data storage structure!

Standard path
To return to the default file directory please press the following button:

Open all protocols
With an activated option all indicated measurement protocols are taken over into the dialog field
whereas a deactivated option will cause containing of only the marked measurement protocols.

Sorting
In order to sort the listed measurement protocols after a search, simply click on the column top after
which the list is supposed to be sorted.
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Manual Selection
[Measure -> Search and edit Measurement Protocols -> Manual Selection]

Please select the button “Single protocol files“ / „Group protocol files“ for the correct protocol type
for searching specific single or group measurement protocols manually.
Thereafter, please choose the directory used for the file search and navigate with double clicks (or by
entering the complete directory path) to the required sub directory. All available protocols as per
search criteria are listed on the right side.

Standard path
To return to the default file directory please press the following button:

Open
All marked protocols are taken over into the dialog.

Sorting
In order to sort the listed measurement protocols after a search, simply click on the column top after
which the list is supposed to be sorted.
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Protocols
[Measure -> Search and edit Measurement Protocols]

The measurement data that has been generated in the automatic measurement mode can be opened,
displayed and measured, the measurement curves can be bundled or protocols may be printed in this
menu.
The listed entries in every line of this table refer to on measurement protocol each. These can be sorted
in the list by any criteria, just click on the corresponding column top. The functions Export... and
Print... are executed in the order as listed in the table!
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Export...
Press the button Export…to export measurement data from the listed protocols, e.g. in the Excel file.
The Export Measurement Data dialog appears.

Please select the required Plug-in . Pressing the key Export… releases the export process. Kindly
select in advance if you with to export Marked protocols only or All protocols. The corresponding
EXCEL-files can later be found in the directory Data.

Print...
Press the key Print... in order to print out single or multiple protocols as list, one page protocol or
curve bundle. The Printout protocols dialog appears.

General
Here you may see the minimum and maximum values (X/Y) of the presently opened measurement file
as well as the program name.

Windows
If the present measurement program includes evaluation windows then their parameters are informed
in the upper and the window results in the lower area. If no evaluation results are available then „n.a.“
appears.
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Meas. Values
The single measurement values of the curve are informed under Meas. Values.
To follow-up single Measurement Curve Values on the measurement curve graphic you have the
choice to make a double click on the measurement values listed on the right. A reference cursor
appears – the right mouse button switches this cursor off again!
The curve values can be scrolled up and down in this list with the help of the up and down keys on
your keyboard – the reference cursor always follows the present value.
If you would like to change the Measurement Curve Presentation or adjust the Graphic Colour
Settings then please do so in the General Settings.

Envelope
If the selected measurement program includes an active Envelope (starting from DIGIFORCE®
firmware V200304) then the additional register card Envelope is displayed.
If the tendency alls Trendnachführung aktiviert ist, sind zusätzliche Angaben hier ebenfalls ersichtlich.

Extras
Here you will find the main information on the protocol file and its origin.
Among other things, the user is informed if an error occured during measurement and which
measurement data is contained in this file.

Zoom
The Zoom stands for the scaling of the Measurement Curve Graphic. You may select Manual and
Auto for setting of the zoom.

Manual
The scaling which was set in the number fields X-min / X-max / Y-min / Y-max always stays the
same in mode Manual Zoom.

Auto
The optimal display is found automatically in the mode Auto in which all active curve types can be
displayed completely.
Please note that the zoom is always automatic in this mode for a change in parameters, even when you
use the navigation.

How to use the graphic
Press the button Tip to find out more about how to use and work with the graphic. You will find
information about zoom, enlargement of ranges, shifting the graphic, etc.
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Printout Protocols
[Measure -> Search and edit Measurement Protocols -> Search Protocols -> Open -> Printout
Protocols]

Selection
Selected Protocols If you wish to select more than one protocol at once, please mark the first and the
last protocol in the list with the left mouse button while keeping the SHIFT key pressed down. With
the STRG-key and the left mouse button you may select single protocols.
All Protocols Selects all protocols from the list.

Printing Options
Page
A separate protocol page with the given results is generated for every measurement process.

List
An overview of all selected protocols is printed in form of a list. Each line corresponds to one
measurement process. There are maximum 40 lines on every protocol page.

Curve array
All marked measurement processes are displayed as curve array. The condition is that the protocol
files actually contain measurement curves and that these were not excluded from data transfer by
menu change. This function only makes sense if the data for the measurement curve derive all from
one source and it has to be the same DIGIFORCE used with the same measurement program and the
same settings. For this reason the source of the data is always indicated.

Print Envelope and Trend curve into graphic
If the first marked measurement protocol contains an envelope curve the activation of this option
results in printout of the Envelope and/or Trend curve into the graphic (not applicable for lists).
As an option, the present user and an individual description can be printed on every protocol (not
applicable for lists). If this is not required, these fields must be erased.
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Definition Device Group
What is a Device Group and what advantages does that have for us?
Basically, you have to decide between a Device List and a Group List. First of all, the DIGIFORCEs
found after using „Search Devices“ are listed in this Device List (list with the DIGIFORCE-symbols at
the beginning of each line).

From here they are selected and taken into the Device Group List (via key „Device Group for
Measurement Mode” below the Device List).
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In the practical process it might be necessary to capture all evaluation results of various singular
operations on a part or element group together and save them to one common group protocol. For
example, the press-fit in operations of all 8 valve seat rings of a cylinder head are included in one
common protocol. To organize this, the DIGIFORCEs involved in such press-fit in operations are
selected and put into one group (see above). The readout of the data is done in the same order as the
DIGIFORCEs are listed in this group. In our example, there were 2 DIGIFORCEs checking the 8
press-fitting operations on valve seat rings. The inlet and outlet ring are pressed in on each valve seat.
A positioning unit places cylinder Z1 and Z4 under the press station in logical sequence. It may also
be that one and the same DIGIFORCE checks all 8 press-fitting operations on this cylinder head
successively. Then this device would be listed 8 times in the group list in the same sequence as the
press-fit operations take place. Distinctions between these single results are possible with the
parameter „Name in the group“!
A Device Group:
• consists of stations that are adapted from the present Device List with the function „Search
devices“ or with „Reload Device List”.
• must consist of minimum one and maximum 32 stations resp. DIGIFORCEs.
• can consist of one/multiple same/different stations. Going to extremes would have one station
being listed 32 times in the Group List.
• can optimize speed for data acquisition by listing the group members in the same chronological
order as the measurements were effected.
• delivers a common group result which corresponds to the summary of results of each single
member. This group result can be saved to a separate protocol file or or printed out.
• creates a group statistic with the single evaluations of all participating group members during
measurement.
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Configurations on Device Group
[Search devices -> Device Group for Measurement Mode -> Settings]

Create a Device Group
Condition to create a Group List is that there are stations already listed in the Device List. This can be
done by searching for a device or reloading a device list.

Choose if you wish to have all devices or only one device to the group list. If there are already devices
in the list you may determine whether the following, unmarked devices should be listed above or
below the marked line.
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A name in the group can be given to each inserted group. This name will serve later for
differentiation during protocol evaluation. Therefore, it makes sense to choose a name in the group
that describes the task of the related group device.
The default setting for the name is the serial number of the station with consecutive numbering.
The following screenshot shows you how to look for a name in the group „Inlet valve-Z3“, for
example.
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Create group protocols
After activation of the checkbox „Create group protocol“ you may create group protocols in addition
to the single protocols. All single results for every group member are listed therein. This group
protocol can later on be documented with a printout of list overview or separate protocol pages in
report form.

Part serial no. counter
In order to identify the produced parts easily at a later time, the user can determine specific settings for
the part serial no. counter.
Screenshot: Gruppenliste-D.jpg
Running counter per batch: If, for example, the batch „day counter“ is selected and you have the
235th day of the year then the part serial nos. would be 235 plus the continuous counter. This would
be reset to 1 when the type of charge counter changes, e.g. from day counter to week counter.
Continuous counter per component: The Serial No. consists of the description entered in the field
„Component name“ and the continuous counter. This is reset to 1 when the component name changes.
Continuous counter: The counter of the part serial no. adds 1 for every component result. When
passing the maximum value of 2147483647 it is reset to 1.
%1 and %2: Optionally, firm parameters can be entered in this field that will not change during the
measurement process. %1 is written before the counter and %2 after! This can be used to create
specific alphanumeric combinations.

Operation Manuel

PC-Software DigiControl 9310

Page 124 to 128

Configuration
Component name: Describes the complete component that is evaluated by the single results of the
component group’s parts. This field must be filled – otherwise, it will be initialized with „Not Init“!
Note: Can be entered optionally and is saved together with the group protocol. An example would be: Test batch
after tool change (max. 30 signs)!
Batch: Selectable are the automatic batch counters „Day Counter“ (where the batch stands for the numerical day
of the year), „Number of Week“ (corresponding to the week of the year) or the „Manual Definition“. The
manual batch always stays the same.

Readout Group
In sequence: With this setting, the measurement results of all devices of the group list are read out in
the preset sequence. It is furthermore possible to set stop criteria such as e.g. „a station sends the
evaluation result NOK“ or “the first station in the group list sends a new result” for the transfer of
NOK measurement results for reasons of time optimization with this feature
Any: With this setting, the group members are questionned for new measurement results in a
reiteration circle. As soon as a group member has supplied new measurement data that are transferred,
this group member is not approached any longer until the completion of the overall group result
(exception: the device is the first member of the group list and the option “finish the group ahead of
time if there is a new result in the first station” was chosen).

Terminate Group prematurely, if...
a station results NOK: It can be determined how to proceed if one of the group members signals
NOK. If „Terminate Group prematurely, if a station results NOK“ was chosen then only the NOKresulting device is read out and the group pass stops rightafter. This makes sense, e.g. if the part has to
be scrapped even at a single NOK-result and if the press fitting of the other components would be
inefficient. If the part should be processed, manually checked and worked on eventually in spite of the
NOK result then the component group must be completely manufactured. In this case, all group
members have to be completely pressed in and read out. Please pay attention to the READY-Mode of
all DIGIFORCEs! Only with READY=1, the station can be started for a new measurement.
New result in first station (only for „in Sequence“): The first device of the group list has supplied
measurement results and later on holds new results within the same group cycle. This results in a start
by the PLC even before the group cycle is completed, the group pass is stopped and the next part no.
follows. The PLC decides the break-off of the group pass due to a NOK signal from one of the
members by restart of the first group member!

Further hints
Group evaluation
The group result is OK only if all group members have the evaluation result OK. The group result is
NOK if min. one group member sends out NOK or the group’s results not completely readout. , e.g.
due to the start of a new group pass.

Configurations „Remote control“ via control communication
Most configurations on the device group can be changed or readout via control communication. As a
result, the part no. of every measurement can be set as a prefix in DigiControl by the PLC with serial
interface.

Field sizes
The sizes of the changeable fieldls are defined as follows:
Part no. „%1“ / „%2“: each with max. 32 characters
Part no. counter: maximum value = 2147483647
Component name: 32 characters
Remark: 64 characters
Manual definition charge: 32 characters
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Important hint
To ensure the capture of all DIGIFORCE measurement results, the READY mode must be respected
by all means. Only with READY=1 the station can be started for a new measurement.
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Statistics on device group
[Search devices -> Device Group for Measurement Mode -> Statistic]

In the left part of the bar chart you have an overview of the OK/NOK-distribution of all group
members listed in the group list. The display colors are classified as follows: OK = green, NOK = red
and not available = yellow (for group „Terminate group prematurely, if...“).
The resulting bars can be positioned linear or parallel (see checkbox).
On the right you find the bar with the evaluation for the complete group. This bar is updated only if a
group protocol is indeed requested. If the readout of the group members stops for whatever reason
during the group cycle then the statistic is not updated!
The statistic of all group members and the total statistic is reset by Reset Statistic.
Important advice:
- „Search devices“ always causes a reset of the previous statistic!
- The group statistic and the configurations on the device group are saved/loaded whenever saving or
loading the device file.
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